Part I 146
Preliminaries ..






Chapter 1
Introducing R

Prerequisites and goals of this chapter

e You may find it useful to read the chapter on installing R in the Appendix first.
e This chapter presents the origins, objectives and specificities of R.

SECTION 1.1
( Presentation of the Software

1.1.1 Origins

R is a piece of statistical software created by Ross lhaka and Robert Gentleman
[21]. R is both a programming language and a work environment. Commands are
executed using descriptive code. Results are displayed as text and the plots are vi-
sualized directly in their own window. R is clone of the statistical software S-plus.
S=plusis an object-oriented programming language S developed by AT&T Bell Lab-
oratories in 1988 [3]. S-plus is used to manipulate data, draw plots and perform
statistical analyses of data.

1.1.2 Why Use R?

First of all, R is free and open-source. It works under UNIX (and Linux), Microsoft
Windows and Macintosh Mac OS: it is cross-platform. It is being developed in the

P. Lafaye de Micheaux et al., The R Software: Fundamentals of Programming 3
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4 1 Introducing R

free software movement by a large and growing community of eager volunteers.
Anyone can contribute to and improve R by integrating more functionalities or
analysis methods. It is thus a quickly and constantly evolving piece of software.

R is a very powerful statistical tool. The learning curve in R is steeper than other
statistical software on the market such as SPSS, SAS or Minitab. R is not the kind of
statistical package, which you can use with a few clicks of the mouse in the menus.
In order to use it, you need to understand the statistical method that you are trying to
implement, so R is a didactic program. R is also very efficient and easy to implement
once you have mastered it. You will be able to create your own tools and you will
be able to handle and work on very sophisticated data analyses.

R is harder to comprehend than other software on the market. You need to
spend time learning the syntax and commands.

R is especially powerful for data manipulation, calculations and plots. Its features
include:

an integrated and very well-conceived documentation system (in English)
Efficient procedures for data treatment and storage;

a suite of operators for calculations on tables, especially matrices;

a vast and coherent collection of statistical procedures for data analysis;
advanced graphical capabilities;

a simple and efficient programming language, including conditioning, loops,
recursion, and input-output possibilities.

For the readers already used to SAS, SPSS or Stata, we advise to read the
books [32, 33] and also to consult the two following Internet websites:

e http://rforsasandspssusers.com
e http://www.statmethods.net

Note also that it is possible to call R functions directly from Matlab using
the R.matlab package and from Excel using the RExcelInstaller pack-
age. Reading of [20] might be useful in this context. Finally, a similar tool
for OpenOffice, called R0OOo, exists; see the Internet website http://rcom.
univie.ac.at.

27
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SECTION 1.2

R and Statistics

Many classical and modern statistical techniques are implemented in R. The most
common methods for statistical analysis, such as

e descriptive statistics;

e hypothesis testing;

e analysis of variance;

e linear regression methods (simple and multiple)

are directly included at the core of the system. It should be noted that most
advanced statistical methods are also available through external packages. These
are easy to install, directly from a menu. They are all grouped and can be browsed
on the website of the comprehensive R archive network (CRAN) (http://cran.
r-project.org). This website also includes, for some large domains of interest,
a commented list of packages associated with a theme (called Task View). This
facilitates the search for a package on a specific statistical method. Furthermore,
detailed documentation for each package is available on the CRAN.

It should also be noted that recent statistical methods are added on a regular basis
by the statistics community itself.

Section A.2, p. 532, gives details on the procedure to install a new package. l

SECTION 1.3

R and Plots

One of the main strengths of R is its capacity (much greater than that of other
software on the market) to combine a programming language with the ability to
draw high-quality plots. Usual plots are easily drawn using predefined functions.
These functions also include many parameters, for example to add titles, captions
and colours. But it is also possible to create more sophisticated plots to represent
complex data such as contour lines, volumes with a 3D effect, density curves, and
many other things. It is also possible to add mathematical formulae. You can arrange
or overlay several plots in the same window and use many colour palettes.
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6 1 Introducing R
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Fig. 1.1: A few of the graphical possibilities offered by R

You can get a demonstration of the graphical possibilities in R by typing in the
following instructions:

demo (image)

example (contour)
demo (graphics)

demo (persp)

demo (plotmath)

demo (Hershey)
require("lattice”) # Load the package, which you must have
previously installed by using the menu
# Packages/Install packages.

£

demo (lattice)
example (wireframe)
require("rgl") #
demo (rgl) #
example (persp3d)

Same remark as above.
You can interact by using your mouse.

Figure 1.1 above shows a few of these plots.
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1.5 First Steps in R 7

SECTION 1.4
( The R Graphical User Interface

The R graphical user interface (GUI) (i.e. its set of menus) is very limited, and com-
pletely nonexistent on some operating systems, when compared to other standard
software. This minimality can set back some new users. However, this drawback is
limited since:

e it has the didactic advantage that it incites users to know well the statistical pro-
cedures they wish to use;
e there are additional tools which extend the GUI.

In the next section, we present the package Rcmdr, which can be installed from
the menu Packages and which allows standard graphical and statistical analyses
with a more user-friendly interface, which includes drop-down menus. Furthermore,
the R instructions for the analysis chosen from the RCommander menus are displayed
in dedicated panel. This can be useful if you do not know (or remember) the R
instruction for a specific task.

Note that after you have learnt R thoroughly, you will be able to develop
yourself tools similar to Remdr, made for a final users who do not desire to
learn R but only to use, in the most user-friendly way, a procedure created by
you. To this end, you can use the package tcltk.

Note that by using RCommander, we are distancing ourselves from what
makes the strength and flexibility of R. We therefore advise against using such
a tool if you wish to become an advanced user.

SECTION 1.5
( First Steps in R

1.5.1 Using RCommander

In this section, we offer a brief introduction to the package Rcmdr. We then present
some functionalities given by this interface for statistical manipulations. We con-
clude by explaining how to add functionalities to the RCommander interface.
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8 1 Introducing R

1.5.1.1 Launching RCommander

Follow these steps to start RCommander.

» Double-click on the R icon on your Desktop.

» In the console, type install.packages("Rcmdr™). Choose a nearby mirror.

» In the console, type require("Rcmdr”). Answer Yes to all the questions you
may be asked. The RCommander graphical interface then opens. Another option
is to click on the menu Packages, then Load package. . ., then Rcmdr.

» In the Messages panel, you should see WARNING: the Windows version of
R Commander works better under RGui with the single document
interface (SDI).

» To remedy this issue, close RCommander.

» In RGui, go to Edit, then Preferences. Check SDI then click on Save. . . and
on Save. You can take this opportunity to customize R.

» Close R and save an image of the session.

» Restart R, then RCommander by typing require("Rcmdr™) in the R console.

We refer the reader to Sect. A.2 which details how to install the package
Rcmdr.

Macintosh users may find useful the instructions at http://socserv.
mcmaster.ca/jfox/Misc/Rcmdr/installation-notes.html, after in-
stalling package tcltk which is available on the CRAN.

The graphical interface of RCommander includes four parts as shown on Fig. 1.2:

(a) Drop-down menus to perform specific tasks

(b) A Script window which presents the code executed thanks to click on a drop-
down menu

(c) AnOutput window which gives the output of the executed code

(d) A Messages window giving a message on the last task

1.5.1.2 Handling Data with RCommander
To perform statistical analyses, you need data.
¢ Entering data by band

Follow these steps to enter data by hand.
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1.5 First Steps in R 9
74 R Commander IE@
File Edit Data Statistics Graphs Models Distributions Tools Help FactoMineR
B‘h Data set:| <No active dataset> [Edit data set ][Vlew data set] Model: | <No active model>
Script Window
< ] »
Output Window | Submit] |
< | »
Messages
[1] NOTE: R Commander Version 1.8-4: Sun Aug 12 12:57:01 2012
< ] »

Fig. 1.2: The RCommander graphical interface

» In the menu Data, choose New data set....

» In the window New data table, choose a name for your data set, for example

Datal.

» A data editor appears. Click on var1l and replace it with Name. Enter a few names

for this variable: Peter, Jack, Ben (see Fig. 1.3).

» Create a variable Height of type numeric with the following values: 182, 184,

190.

» Click on the cross (X) at the top-right corner of the active window to close the

data editor.
» You can visualize your data set by clicking on View.

We can now calculate some basic statistics.
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10 1 Introducing R

I ™

7% R Commander [s®=]
File Edit Data Statistics Graphs Models Distributi Tools Help FactoMineR
R, Data set:| <to active dataset>| [Edit data set][View data set]  Model: | <No active model>
Script Window
R oata ditor S S| =ElE]
Name var2 varé
1 |Pierre type © numeric @ character
2 |Remy
3 |Benoit
l — 4
Output Wir :
¥/
8
9
10
11
12
13
34
)
16
alz/
18
19
[
< ] »
Messages
[1] NOTE: R Commander Version 1.8-4: Sun Aug 12 12:57:01 2012 -~
< ] »

Fig. 1.3: Entering data with the RCommander graphical interface

e Basic statistics

Follow these steps to get some basic statistics on your data set:

» In the menu Statistics, choose Summary, then Descriptive stati-
stics

» A window called General statistics opens up; the only numeric variable
in our data set is the variable Height.

» Choose the statistics Mean, Standard deviationand Quantiles and click on
OK.

» The result is displayed in the Output window. Note that you can check the R
instruction which was used for this task in the Script window (see Fig. 1.4).
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1.5 First Steps in R

11

74 R Commander

File Edit Data Statistics Graphs Models Distril

Tools  Hell /o b,

7% Numerical Summaries

B& Data set:! Datat l [Edit data set]lview data set] Model: E

(pick one or more)

Script Window 9 A
Datal <- edit(as.data.frame (NULL)) Mean v
library(abind, pos=4) iati v
library(el071, pos=4) SiacaiDatation &
numSummary (Datal[, "Height"], statistics=c("mean", " Coefficient of Variation I~
antiles=c(0,.25,.5,.75,1))
e e Skewness [~ Type 10
Kutosis [~ 1YPe2@
Type 30
T Quantiles ¥ quantiles: 0, .25, 5, .75, 1
Output Window Summarize by groups... |
[ OK ] [ Cancel ] [ Reset ] [ Help
> Datal <- edit(as.data.frame (NULL))
> library(abind, pos=4)
> library(e1071, pos=4) File Edit Help
Name Height |var3
> numSummary (Datal[,"Height"], statistics=c("mean"”, "sd", "quantiles"), -
+ quantiles=c(0,.25,.5,.75,1)) 1 |Pierre |[180
mean sd 0% 25% 50% 75% 100% n 2 |Remy 182
184 5.291503 180 181 182 186 190 3 3 |Benoit |190
.
5
6
7
8
9
v 10
< i » 11
Messages 12
[1] NOTE: R Commander Version 1.8-4: Sun Aug 12 12:57:01 2012 - 13
[2] NOTE: The dataset Datal has 3 rows and 2 columns. D 14
i 15
< ] »

Fig. 1.4: Basic statistics with RCommander

Note that it is also possible to type an instruction directly in the Script window
without using a menu. Here is an example.

» Type in the Script window:

numSummary (Datall[, "Height"] ,statistics=c("mean", "sd"))

» Click on that line so that the cursor is displayed there, then click on Submit.

» You have just computed the mean and standard deviation of variable Height

which contains 3 observations. The result appears in the Output window:

mean sd $ n
184 5.291503 0 3

e Manipulating the data set

In our toy example, suppose that we also have the weight and wish to compute
the body mass index: BMI = Weight | Height* (height in metres).
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12 1 Introducing R
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74 R Commander [E]

File Edit Data Statisti Graphs Models Distributions Tools Help FactoMineR

E«h Data set:| Datal [Edit data set ”Vlew data setl Model: | <No active model>

Script Window
Datal <- edit(as.data.frame (NULL)) -
1ibraxy (abind, ({iE
library(el071,
numSummary (Datg
quantiles=c ((
fix (Datal)
library(relimp,
showData (Datal,

maxheight=30) New variable name Expression to compute

| r———— BMI weight/ ( (Height/100) **2)|

< L
Output Window [ OK ] [ Cancel ] [ Reset ] [ Help ]

> Datal <- edit

> library(abind, pos=4)
> library(el071, pos=4)
> numSummary (Datal[, "Height™], statistics=c("mean”, "sd", "quantiles"),
+ quantiles=c(0, .25,.5,.75,1))
mean sd 0% 25% 50% 75% 100% n
184 5.291503 180 181 182 186 190 3
> fix(Datal)

> library(relimp, pos=4)

> showData (Datal, placement='-20+200', font=getRcmdr ('logFont'), maxwidt
+ maxheight=30)

1

< | m »

Messages

[2] NOTE: The dataset Datal has 3 rows and 2 columns.
[3] NOTE: The dataset Datal has 3 rows and 3 columns.

4[] »

« | ] »

>
>

Fig. 1.5: Manipulating a data set with RCommander

Click on Edit (below the RCommander menus).
The data editor opens up and you can add the numeric variable Weight, with the
following values: 70, 72 and 75. Now close the data editor.

» In the Data menu, choose Manage variables in the active data set,

then Calculate a new variable....A window opens.

» For Name of new variable, type BMI and for Expression to calculate:

Weight/((Height/100)**2) (see Fig. 1.5). Click on OK to complete the calcu-
lation.

» Click on View to see the result for your data set.
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1.5 First Steps in R 13

You are starting to feel tired and need a coffee break! But before you take one, follow
these steps to save your data set.

» In the Data menu, choose Active dataset,then Save active dataset....

» A window opens. You can choose a location to save your data set. We shall call
it BMI and by default it has the .RData extension.

» Close RCommander and answer OK to the question Do you wish to quit?,No
to Save script file? and No to Save output file?.

» You can now close R and answer No to the question Save session image?.

After a well-deserved break, you wish to add new data to your file BYI.RData.

» Open an R session. Type 1ibrary ("Rcmdr™).

» In the Data menu, choose Load data set....

» A window opens. Navigate to and open the file BUI.RData.

» Click on View to display your data set.

» Add the information for a new person ("Julia", Height=150, Weight=52) by
clicking on Edit.

» After closing the editor, you can check the changes by clicking on View. You
then see the value NA (not available) for Julia’s BMI.

» To get Julia’s BMI, you need to go through the steps of section manipulating the
data set again. We shall see later on how to create a function which calculates
the BMI in a more user-friendly fashion.

You now wish to send your data set to a colleague who does not use R yet.

» In the Data menu, choose Active dataset, then Export active data
set ....

» A first window opens. Uncheck the box Write names of individuals
(rows) since we have not defined these. Choose Spaces for the field
separator.

» Click on OK. A second window opens. You can choose a place to save your data
set. We shall call it BMI and it has the default extension . txt.

» You can now send your data set BMI. txt to your colleague and use this opportu-
nity to mention the wonderfulness of R, which has a rather user-friendly interface
for data manipulation.

1.5.1.3 A Few Statistical Tasks with RCommander

In this section, we present a brief overview of how to use RCommander for statistical
tasks. We start with a mean comparison test and a chi-square test of independence.
We then show how to use RCommander to visualize the standard distributions
(binomial, poisson, normal, gamma, etc.). We conclude with a linear model fit.
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14 1 Introducing R

e Mean comparison test 195

We propose to use data already available in R. Follow these steps to load a data 197
set: 198

» In the Data menu, choose Data in packages, then Read data from an 199

attached package.... 200
» A window opens. Double-click on datasets in the Package section, then on 201
sleep in the right column. 202
» sleep appears in the box Enter a dataset name (see Fig. 1.6). 203
» You can now click on Help on the selected dataset to have some infor- 204
mation about it. 205
» Click on OK to close the previous window, then visualize the data set by clicking 206
on View. 207

These data are used to compare the effect on sleep of a soporific drug, compared to 208
a control group. We shall first visualize the distribution of sleep gain in both groups, 209
then do a mean comparison test to see whether there is any statistical significant 210

difference between the drug and the control. 211
» In the Graphs menu, choose Box plot.... 212
» A window opens. Click on Plot by group.. ., then on the variable group, 213

then on OK twice. 214

» You can now see two box plots representing the sleep time gain in both groups. 215
» You can save this plot by clicking on File, then Save as. Several formats are 216
possible. 217

You can also enhance this plot, for example, by adding colours. In the script window, 218
type 219

boxplot (extra~group,ylab="extra",xlab="group",data=sleep,
col=c("red";"blue"))

then click on Submit. 220
@ Chapter 7 is dedicated to plots in R. '
We now perform a mean comparison test. 221
» In the Statistics menu, choose Means, then independent t-test.... 222
» Click on group in section Groups (one). You now see specified the difference 223
1-2 (group 1 vs. group 2). 224
» Click on OK to see the result in the Output window (see also Fig. 1.6). 225

The p-value of this test (greater than 5 %) does not allow us to conclude that 226
there is a significant difference between the sleep gains given by the drug and the 227
control. 228
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74 R Commander E

_File Edit Data Statistics Graphs Models Distributions Tools Help FactoMineR

B‘h Data set:| sleep [Edit data set”\ﬁew data set] Model: M

Script Window

data (sleep, package="
t.test (extra~group, a

Package (Double-click to select) Data set (Double-click to select)

var.equal=FALSE, da| &' - sunspot.year i
sunspots
MASS D| swiss E
survival - reering -
OR
Enter name of data set: sleep
< | [Help on selected data set]

Output Window [ ok | [ canca |

> data(sleep, package="datasets")

> t.test (extra~group, alternative='two.sided', conf.level=.95,
+ var.equal=FALSE, data=sleep)

Welch Two Sample t-test

data: extra by group
t = -1.8608, df = 17.776, p-value = 0.07939
alternative hypothesis: true difference in means is not equal to 0
95 percent confidence interval:
-3.3654832 0.2054832
sample estimates:
mean in group 1 mean in group 2
0.75 2.33

< | ] »
Messages

== =

[4] NOTE: The dataset sleep has 20 rows and 3 columns. @

< ] »

Fig. 1.6: Mean comparison test with RCommander

e Test on a double entry table

In a therapeutic test, the underlying question is whether a treatment on HIV-
positive mothers has an effect on the HIV status of the child. If it does not, then the
HIV status of the child is independent of the treatment taken by the mother. In this
test, out of 391 children, 100 are HIV negative, 193 have mothers under treatment
and 41 are HIV positive and have mothers under treatment. To know whether the
treatment has an effect, follow these steps:
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7 R Commander e
File Edit Data Statistics Graphs Models Distributions Tools Help FactoMineR
g«h Data set:| <No active datase(>‘ [Edit data sel"\ﬁew data sel] Model: | <No active model>
Script Window 'wo-Way T:
rownames (.Table) <- c('Treat', 'Contr') o -
colnames (.Table) <- c('HIV+', 'HIV-') Number of Rows: | 2
.Table # Counts - (L §
totPercents(.Table) # Percentage of Total Number of Columns: | 2
.Test <- chisq.test(.Table, correct=FALSE) Enter counts:
.Test HIV+ HIV- £
.TestSexpected # Expected Counts
remove (.Test) Treat 41 152
remove (.Table) Contr 59 139
Compute Percentages ¥
< Row ®
Output Window Column percentages
Percentages of total « o
> .Test <- chisq.test(.Table, correct=FALSE) No percentages
> .Test Hypothesis Tests
Chi-square test of independence ¥
Pearson's Chi-squared test . e
Components of chi-square statistic |~
davar sEable Print expected frequencies 2
X-squared = 3.7574, df = 1, p-value = 0.05257 =
Fisher's exact test ]
> .Test$expected # Expected Counts [ OK ] [ Cancel ] [ Reset ] [ Help
HIV+ HIV-
Treat 49.36061 143.6394 =
Contr 50.63939 147.3606
> remove (.Test)
> remove (.Table)
< »
Messages
[1]) NOTE: R Commander Version 1.8-4: Sun Aug 12 13:16:33 2012 =
<« ] »

Fig. 1.7: Independence test with RCommander

» In the Statistics menu, choose Contingency tables, then Fill and 237
analyse a double entry table.... 238

» A window opens.  Fill the table as indicated in Fig.1.7. Choose 239
Total percentagesand Print expected frequencies. 240

» Click on OK to see the result in the Output window. 241
At the 5 % risk level, we cannot conclude that the treatment has an effect on the 242
child’s HIV status. 243
244

¢ Exploring distributions 245
246

RCommander can be used to visualize standard distributions. 247

» In the Distributions menu, choose Continuous distributions, the 248
Normal distribution,then Plot of normal distribution.... 249

» A window opens. Specify a mean of 4 and a standard deviation of 2. Click on OK. 250
» The curve of the density of a normal distribution centred at 4 and with standard 251
deviation 2 appears in a graphical window. 252
You can follow the same steps for other probability distributions. 253

254
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o Fitting a linear model

RCommander can be used to easily fit standard regression models. We illustrate
this with the linear model. We shall first download a data set from an Internet
address (URL). It contains the measures, for 80 patients with a disabling illness,
of the variables GENDER (1 = Male, 2 = Female), WEIGHT (in kg), HEIGHT (in
cm), PAIN (ordinal variable: a=least pain), DISTANCE (number of metres walked),
MOBILITY (self-evaluation of mobility; 1=most mobile) and STAIRS (number of
steps climbed).

» In the Data menu, choose Import data, then from a text file, the
clipboard or a URL....

» A window opens. Call the data table I11ness. Check the box Internet link
(URL) in Data file and the box Tabulations for Field separator; click
on OK.

» In the field Internet link (URL), type
http://biostatisticien.eu/springeR/illness.txt.

» Click on OK and you should see the following in the Messages window: The
illness data set contains 80 rows and 8 columns.

We shall fit a multiple regression model. Follow these steps.

» In the Statistics menu, choose Model fitting,then Linear regression

» Choose for example Model .1 as your model name in the field Enter a name
for the model.

» Choose variable DISTANCE as the response variable, and variables WEIGHT and
HETGHT as the explanatory variables (keep the CTRL key pressed).

» Click on OK. The result of your linear model adjustment appears in the Output
window. This result corresponds to the instructions

Model.l <-  lm(DISTANCE~WEIGHT+HEIGHT,data=Illness)
summary (Model.l)

which are shown in the Script window.

Chapter 14 presents the linear model in further detail. '

We now visualize the least squares plane corresponding to the fitted model.

» In the P1lot menu, choose 3D plot, then 3D scatterplot....

» Choose variable DISTANCE as the response variable and the variables WEIGHT
and HEIGHT as explanatory variables (use the CTRL key).

» Choose Ordinary least squares as the surface to fit. Click on OK.
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18 1 Introducing R

DISTANCE
500

WEIGHT

10999 ————— 2

Fig. 1.8: Least squares plane

You can now see the 3D scatterplot (shown in Fig. 1.8) and the least squares
plane. You can move the image with your mouse.

1.5.1.4 Adding Functionalities to the RCommander Interface
Some packages available on the official R website can also be integrated to

the RCommander menus. They are easy to identify: their names start with
RcmdrPlugin. We now illustrate how to use such a package.

@ You can read the article [17] which explains how to build a package for
RCommander integration.

e The TeachingDemos package

The RemdrPlugin. TeachingDemos package can be used to illustrate some sta-
tistical concepts.

» Type install.packages("RcmdrPlugin.TeachingDemos") in the Script
window. Click on Submit and choose a nearby mirror. Once the installation is
complete, close and reopen RCommander using the instruction Commander ().

» In the Tools menu, choose Load Rcmdr plug-ins...,click on OK and answer
Yes to the question Restart now?.

» There is a new menu called Demos. In this menu, you can choose for example the
submenu Simple Correlation and explore the notion of correlation.
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1.5 First Steps in R 19

This plug-in also adds submenus to pre-existing menus. For example, in the
Distributions menu, you can now choose Visualize distributions, then
t distributions. By checking Show Normal Distribution, and by playing
with the d.f. (degree of freedom) cursor, you can visualize the closeness of the
Student distribution and the normal distribution.

e The sos package

The RemdrPlugin. sos package can be used to ease the search for help on a
given concept or function. Follow the same steps as before to install this plug-in. A
new submenu called Search R Help ... (sos) appears in the Help menu. Ex-
plore this new Rcommander functionality, for example, by typing 1inear model.

Chapter 6 describes how to search for information about R. '

1.5.2 Using R with the Console

In the previous subsection, we saw how to use R through menus. In fact, this way
of proceeding is far from optimal, since it imposes many limitations on the possi-
bilities offered by R. Many analyses, either deeper or more recent and innovative,
are not available in the RCommander menus. It is thus very useful to escape from
the “button clicking” approach and master the R programming language. You will
then be able to perform simulations and to code repetitive tasks. We have already
encountered a few R instructions when using RCommander, which is itself a tool
written in the R language. We now propose a brief introduction to a few elements
of the R syntax, first through an analysis of complex data arising from a functional
magnetic resonance imaging (MRI) experiment, then by letting the reader type a
few R commands and think about the output.

1.5.2.1 The Strength of R Shown on an Example

Some neuroscientists work on finding which part of the brain deals with visual
information on colour. To this end, a visual stimulus, consisting in an alternance
of coloured and non-coloured moving patterns, is shown to a subject. During this
time, volumic images of the subject’s brain are acquired at time = 1, ..., T with
an MRI scanner. Each 3D image is in fact a large (Rubik’s!) cube made of many
voxels, the 3D equivalents of 2D pixels. At time t = 1,..., 7T, each voxel con-
tains an electromagnetic measurement value x(z). We can thus consider that in
each voxel, we have observed a time series {x(t);t = 1,...,T} representing
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20 1 Introducing R

electromagnetic variations. The acquired data (given in file Mond4D.nii, produced
during a Mondrian experiment performed by M. Dojat and J. Huppé) thus consist in
a 4-dimensional array, the concatenation of several volumic brain images measured
through time.

We used R to find, in each brain slice, which voxel had temporal variations
most correlated with the stimulus signal. The code below can be downloaded from
http://biostatisticien.eu/springeR/brain-code.R and opened, thanks
to the submenu Open script... of the File menu in R. The key combination
CTRL+R then executes one by one the instructions of this script. You can try to
execute these instructions to visualize the results. This will help you familiarize
yourself with some of the possibilities offered by R.

We first download the data files we need (the files Mondanat.img and
Mondanat.hdr contain an anatomical image of the subject’s brain).

getfile <- function(myfile)

download.file(paste ("http://biostatisticien.eu/springeR/",
myfile,sep="") ,paste(getwd(),"/", myfile, sep="") ,mode="wb")
getfile ("Mond4D.nii")
getfile ("Mondanat.hdr")
getfile ("Mondanat.img")

vV V.V + + Vv

We then install the package to read the data.

> install.packages ("AnalyzeFMRI") # Choose a mirror.

> # File names.
> file.func <- paste(getwd(),"/","Mond4D.nii", sep="")
> file.anat <- paste(getwd(),"/","Mondanat.img",sep="")

> # Brain slice number.
> slice <- 10

The next instructions read the data.

> anat.slice <- f.read.nifti.slice(file.anat,slice,1)

> class'(anat.slice)

[1] “matrix"

> dim(anat.slice)

3] 128 128

> func.slice <- f.read.nifti.slice.at.all.timepoints(file.func,
slice)

> class (func.slice)

[1] "array"

> dim(func.slice)

[1] 128 128 125

We now create the coding of the visual stimulus signal (1=colour, 0=no colour).

> stimulus <- c(rep(ec(1,1,1,1,1,0,0,0,0,0,0,0,0,0,0),8),1,1,1,1,1)
> plot(stimulus, type="1")
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355

We compute correlations between the observed time series in each voxel and the 356

stimulus series.

> corMat <- matrix(NA,nrow=128,ncol=128)

> for (i in 1:128) {
+ for (j in 1:128) {

+ corMat[i,j] <- cor(func.sliceli,j,],stimulus)

+
+ 3

357

We can now compute the coordinates of the voxel most strongly correlated with 3ss

the stimulus

> which (abs (corMat)==max (abs (corMat) ,na.rm=TRUE) , arr.ind=TRUE)

row col
[1,] 67 117

and the correlation value of this voxel

> corMat[67,117]
[1] -0.6675017

We can then plot the time series observed in this voxel.

> par(mfrow=c(2,1))
> plot(stimulus, type="1")

> plot(func.slicel67,117,],type="1",ylab="Intensity")
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We are now able to identify on the anatomical image of the brain the most active 363
voxel for the visual stimulus. 364
> image (as.matrix(rev(as.data.frame(t(anat.slice)))),

col=gray((0:32)/32))
> points(117/128,67/128,col="red",cex=2,pch=19)
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Note that you can also visualize these data in 3D. The following instructions, 3es
taken from the help file for the function contour3d() from package misc3d, give 3e7
an interactive 3D view of the brain. 368

> install.packages ("misc3d")

> require ("misc3d")

> a <- f.read.analyze.volume (system.file("example.img",

+ package="AnalyzeFMRI"))

> a<-al,,,1]

> contour3d(a,1:64,1:64,1.5%(1:21),lev=c (3000, 8000, 10000),
+ alpha=c(0.2,0.5,1) ,color=c("white", "red", "green"))
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You can try to move the image with your mouse.

23

1.5.2.2 A Brief Introduction of R Syntax Through Some Instructions to Type

e Basic operations

We advise the reader to play with these commands and try to understand how

they work.

> 1%2%3%4

[1] 24

> factorial (4)

[1] 24

> cos (pi)

[1] -1

> x <=:1:10

> x
[1] 1 "2 3 4 5 6 7 8 9 10

> exp(x)
[1] 2.718282 7.389056 20.085537
[5] 148.413159 403.428793 1096.633158
[9] 8103.083928 22026.465795

> x72
[1] 1 4 9 16 25 36 49 64 81 100

> chain <- "R is great!™"

> chain

[1] "R is great!™"

> nchar (chain)

[1] 11

> ?nchar

54.598150
2980.957987
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> M <- matrix(x,ncol=5,nrow=2)

> M

[,1] [,2] [,3] [,4] [,5]
[1,] 1 3 5 7 9
[2,] 2 4 6 8 10
> MI[2,3]
[1] 6

> L <- list(matrix=M,vector=x,chain=chain)
> LI[3]1]

[1] "R is great!"

> while (TRUE) {

toguess <- sample(1:2,1)

+

1 Introducing R

+ {cat("Guess a number among 1, 2, 3: ") ; value <- readline()}
+ if (value == toguess) {print("Well done!") ; break()}

+ else print ("Try again.")

+ )

> 1s()

[l] "chain n "L n "M" "x n

> rm(chain)

The following commands perform matrix operations:

> A <- matrix(runif (9) ,nrow=3)
> 1/A

[,1] [,2] [,3]
[1,] 2.270797 1.546875 1.422103
[2,] 1.268152 1.957924 1.057803
[3,] 1.642736 5.273120 2.174020
> A * (1/Aa)

[,1] [,2] [,3]

[1,] 1 1 1

[2,1]1 1 1 1

[3,1]1 1 1 1

> B <- matrix(1l:12,nrow=3)
> A * B

Error in A * B : non-conformable arrays
> A %*% B

[,1] [,2] [,3] [,4]
[1,] 3.842855 9.212923 14.582990 19.95306
[2,] 4.646105 11.380053 18.114001 24.84795
[3,d 2.367954 6.143031 9.918107 13.69318
>. (invA <- solve(a))

[,1] [,2] [,3]1
[1,] 1.145642 -3.376148 5.187347
[2,] 4.379786 -4.641906 2.844607
[3,] -3.321872 6.381822 -5.863772
> A %%*% invA

[,1] [,2] [,3]
[1,] 1.000000e+00 0.000000e+00 0
[2,] 0.000000e+00 1.000000e+00 0

[3,] -2.220446e-16 4.440892e-16 1
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> det (a)
[1] 0.04857799
> eigen(A)
Svalues
[1] 1.6960690+0.000000i -0.1424863+0.0913191
[3] -0.1424863-0.0913191
Svectors
[,1] [,2] [,3]
[1,] 0.5859852+0i 0.6140784-0.1816841i 0.6140784+0.18168411i
[2,] 0.7064296+0i 0.2234155+0.25055281i 0.2234155-0.25055281
[3,] 0.3969616+0i -0.6908020+0.0000000i -0.6908020+0.00000001

o Statistics 377

378
Here are a few statistical calculations. 379

> weight <- ¢(70,75,74)

> mean (weight)

[1] 73

> height <- ¢(182,190,184)

> mat <- cbind(weight,height)

> mat

weight height
[1,1 70 182
[2,1]1 75 190
[3,1 74 184

> apply (mat,MARGIN=2, FUN=mean)
weight height
73.0000 185.3333
> ?apply
> colMeans (mat)
weight height
73.0000 185.3333
> names <- c("Peter","Ben", "John")
> data <- data<frame (Names=names,height,weight)
> summary (data)

Names height weight
Ben :1 Min. :182.0 Min. :70.0
John :1 lst Qu.:183.0 1st Qu.:72.0
Peteral Median :184.0 Median :74.0

Mean :185.3 Mean :73.0
3rd Qu.:187.0 3rd Qu.:74.5
Max. :190.0 Max. :75.0
e Some plots 380

381

> £ <- function(x) x"2-2%x-2
> curve (f,xlim=c(-5,2)) ;abline (h=0)
> locator(l) # Click on the intersection of the two curves.
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> uniroot (£,c(-5,2))
Sroot

[1] -0.7320503
Sf.root

[1] -1.874450e-06
Siter

[1] 8

Sestim.prec

[1] 6.103516e-05

> plot(cars)
> abline(lm(dist~speed,data=cars),col="blue")
> points(cars[30,],col="red",pch=20)
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> par (mfrow=c(1,2))
> hist (cars$speed,main="Histogram")
> boxplot (cars$dist,col="orange")

1 Introducing R
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This link points to a reference card of the most useful R functions http://
cran.r-project.org/doc/contrib/Short-refcard.pdf
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